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UNIT-V 

.NET APPLICATION DOMAINS 
.NET, each application runs in an application domain under the control of a host. The host 

creates the application domain and loads assemblies into it.  

Application Domains 
.NET, each application runs in an application domain under the control of a host. The 

host creates the application domain and loads assemblies into it. The host has access to 

information about the code via evidence. This information can include the zone in which the 

code originates or the digital signatures of the assemblies in the application domain. The 

System.AppDomain class provides the application domain functionality and is used by hosts. A 

host can be trusted if it provides the CLR with all the evidence the security policy requires. 

There are several types of application hosts: 

·        Browser host-includes applications hosted by Microsoft Internet Explorer; runs 

code within the context of a Web site. 

·        Server host-regarding ASP.NET, refers to the host that runs the code that handles 

requests submitted to a server. 

·        Shell host-refers to a host that launches applications, namely .exe files, from the 

operating system shell.  

·        Custom-designed host-a host that creates domains or loads assemblies into domains 

(e.g., dynamic assemblies). 

 

 

 

 

Running an Application with a Specific Evidence and Zone 
String myApplication = @"C:\MyApp.exe"; String[] argsToApp = null; 

String myURL = @"http://www.readorrefer.in"; SecurityZone myZone = 

SecurityZone.Internet; Evidence myEvidence = new Evidence(); 

myEvidence.AddHost(new Zone(myZone)); myEvidence.AddHost(new Url(myURL)); 

AppDomain app = AppDomain.CreateDomain(myApplication, myEvidence); 

app.ExecuteAssembly(myApplication, myEvidence, argsToApp); 

.NET REMOTING 
The .NET Remoting provides an inter-process communication between Application 

Domains by using Remoting Framework. 
Remoting 

The .NET Remoting provides an inter-process communication between Application 

Domains by using Remoting Framework. The applications can be located on the same computer , 

different computers on the same network, or on computers across separate networks. The .NET 

Remoting supports distributed object communications over the TCP and HTTP channels by 

using Binary or SOAP formatters of the data stream. 

The main three components of a Remoting Framework are : 

1. C# Remotable Object 

2. C# Remote Listener Application - (listening requests for Remote Object) 

3. C# Remote Client Application - (makes requests for Remote Object) 

The Remote Object is implemented in a class that derives from 

System.MarshalByRefObject . 



 
You can see the basic workflow of .Net Remoting from the above figure. When a client calls the 

Remote method, actually the client does not call the methods directly . It receives a proxy to the 

remote object and is used to invoke the method on the Remote Object . Once the proxy receives 

the method call from the Client , it encodes the message using appropriate formatter ( Binary 

Formatter or SOAP Formatter ) according to the Configuration file. After that it sends the call 

to the Server by using selected Channel ( TcpChannel or HttpChannel ). The Server side 

channel receives the request from the proxy and forwards it to the Server on Remoting system, 

which locates and invokes the methods on the Remote Object. When the execution of remote 

method is complete, any results from the call are returned back to the client in the same way. 

Before an object instance of a Remotable type can be accessed, it must be created and 

initialized by a process known as Activation. Activation is categorized in two models , they are 

Client-activated Objects and Server-activated Objects. 

 C# Remote Activation 

  The real difference between client-activated and server-activated objects is that a server-

activated object is not really created when a client instantiates it. Instead, it is created as needed. 

By default the .NET Framework ships with two formatters(Binary Formatter or SOAP Formatter 

) and two channels(TcpChannel ,HttpChannel). 

 

C# Remote Channels 

C# Remote Formatters 

Formatters and Channel are configured by using Configuration files. It can be easily Configured 

by using XML-based files. 

C# Remote Configuration 

.NET LEASING AND SPONSORSHIP 
   .NET manages the lifecycle of objects using garbage collection. .NET keeps track of memory 

allocation and objects accessed by all the clients in the app domain. 

Leasing and Sponsorship 
  .NET manages the lifecycle of objects using garbage collection. .NET keeps track of 

memory allocation and objects accessed by all the clients in the app domain. When an object 

becomes unreachable by its clients, the garbage collector eventually collects it. If the objects are 

in the same app domain as the clients, garbage collection functions fine. In fact, even in the case 

of a client in one app domain accessing an object in a different app domain in the same process, 



garbage collection still works, because all app domains in the same process share the same 

managed heap. In the case of remote objects accessed across processes and machines, however, 

the strategy breaks down because the object may not have any local clients. In this case, if 

garbage collection were to take place, the garbage collector would not find any references to the 

object and would deem it garbage, even though there are remote clients (on other machines, or 

even in separate processes on the same machine) who wish to use the object. The rest of this 

section addresses this challenge. 

In the following discussion, a "remote object" is an object in a different process. The core 

piece of the .NET remoting architecture designed to address this problem is called leasing and 

sponsorship. The idea behind leasing is simple: each server object accessed by remote clients is 

associated with a lease object. The lease object literally gives the server object a lease on life. 

When a client creates a remote server object (that is, actually creates it, rather than connects to an 

existing instance), .NET creates a lease object and associates it with the server object. A special 

entity in .NET remoting called the lease manager keeps track of the server objects and their lease 

objects. Each lease object has an initial lease time. The clock starts ticking as soon as the first 

reference to the server object is marshaled across the app domain boundary, and the lease time is 

decremented as time goes by. As long as the lease time doesn't expire, .NET considers the server 

object as being used by its clients. The lease manager keeps a reference to the server object, 

which prevents the server object from being collected in case garbage collection is triggered. 

When the lease expires, .NET assumes that the server object has no remaining remote clients. 

.NET then disconnects the server object from the remoting infrastructure. The server object 

becomes a candidate for garbage collection and is eventually destroyed. After the object is 

disconnected, any client attempt to access it results in an exception of type RemotingException, 

letting the client know the object has been disconnected. This may appear strange at first, 

because the object may very well still be alive. .NET behaves this way because otherwise, the 

client's interaction with the remote object will be nondeterministic. If .NET allowed remote 

clients to access objects past their lease time, it would work some of the time but would fail in 

those cases in which garbage collection had already taken place. 

.NET CODING DESIGN GUIDELINES 
   .NET Coding Design Guidelines: Â· Naming Guidelines Â· Class Member Usage Guidelines 

Â· Guidelines for Exposing Functionality to COM  

NET Coding Design Guidelines 
·        Naming Guidelines 

·        Class Member Usage Guidelines 

·        Guidelines for Exposing Functionality to COM   

·        Error Raising & Handling Guidelines 

·        Array Usage Guidelines 

·        Operator Overloading Usage Guidelines 

·        Guidelines for Casting Types 

·        Common Design Patterns 

·        Callback Function Usage 

·        Time-Out Usage 

·        Security in Class Libraries 

·        Threading Design Guidelines 

·        Formatting Standards 

·        Commenting Code 



·        Code Reviews 

·        Additional Notes for VB .NET Developers 

.NET ASSEMBLY 
  There are two kind of assemblies in .NET; Â· private Â· shared  

Assemblies 

The .NET assembly is the standard for components developed with the 

Microsoft.NET. Dot NET assemblies may or may not be executable, i.e., they 

might exist as the executable (.exe) file or dynamic link library (DLL) file. All the 

.NET assemblies contain the definition of types, versioning information for the 

type, meta-data, and manifest. The designers of .NET have worked a lot on the 

component (assembly) resolution. 

 

 

There are two kind of assemblies in .NET; 

        private 

        shared 

 Private assemblies are simple and copied with each calling assemblies in the 

calling assemblies folder. 

 Shared assemblies (also called strong named assemblies) are copied to a single 

location (usually the Global assembly cache). For all calling assemblies within the 

same application, the same copy of the shared assembly is used from its original 

location. Hence, shared assemblies are not copied in the private folders of each 

calling assembly. Each shared assembly has a four part name including its face 

name, version, public key token and culture information. The public key token and 

version information makes it almost impossible for two different assemblies with 

the same name or for two similar assemblies with different version to mix with 

each other. 

  An assembly can be a single file or it may consist of the multiple files. In 

case of multi-file, there is one master module containing the manifest while other 

assemblies exist as non-manifest modules. A module in .NET is a sub part of a 

multi-file .NET assembly. Assembly is one of the most interesting and extremely 

useful areas of .NET architecture along with reflections and attributes, but 

unfortunately very few people take interest in learning such theoretical looking 

topics. 

  

 

What are the basic components of .NET platform? 

The basic components of .NET platform (framework) are: 



 
 

XML Web Service Application 
   On your local computer (localhost), start Visual Studio .NET. On the File menu, click 

New and then click Project. Under Project types click Visual Basic Projects, then click ASP.NET 

Web Service under Templates. Name the project TestService. 

XML WEB SERVICE APPLICATION 


   On your local computer (localhost), start Visual Studio .NET. On the File 

menu, click New and then click Project. Under Project types click Visual 

Basic Projects, then click ASP.NET Web Service under Templates. Name 

the project TestService. 


   In Solution Explorer, change the name of Service1.asmx to Services.asmx. 
 


   Open Services.asmx in the visual designer. In the Properties window, change 

the Name property of the Service1 class to Services. 


   Save the project. 

Create the XML Web Service Methods 


   Open Services.asmx in the code editor. 


   Add the following code within the Services class definition to create various 

Web methods: 

<WebMethod()> Public Function GetMessage() As String Return "Today is 

the day" 

End Function <WebMethod()> _ 
 

Public Function SendMessage(ByVal message As String) As String Return 

"Message received as: " & message 
 

End Function <WebMethod()> _ 
 



Public Function ReverseMessageFunction(ByVal message As String) 

As String Return StrReverse(message) 
 

End Function 

  

<WebMethod()> Public Sub ReverseMessageSub(ByRef message As 

String) message = StrReverse(message) 

  

End Sub Save and build the project. 

  

Test the Services with Visual Studio .NET 


   In Solution Explorer, right-click Services.asmx and then click View in 

Browser. 
 


   Follow these steps to use the built-in browser to test each Web 

method:NOTE: You cannot test the ReverseMessageSub procedure because 

it expects a ByRef argument. 
 

  Click the hyperlink for the method that you want to test. 

  Fill in any requested message parameter values. 

  Click Invoke. 

  View the resulting XML and close the results window. 

 

  Click the Back button to return to the method list and repeat the steps 

for the remaining Web methods. 

 

  Close the built-in browser. 

  

Create the Test Client Application 


   On the File menu, click Add Project, and then click New Project. 
 


   Select Visual Basic Console Application, and then name the project 

TestHarness. 
 


   On the Project menu, click Add Web Reference. 

 


   In the Address field, type http://localhost/TestService/Services.asmx, and then 

click Go. 
 




   Click Add Reference to finish creating the Web reference. 

 


   In Solution Explorer, right-click localhost in the Web References folder, click 

Rename, and then change the name to WebService. This becomes the 

namespace that is used within the test application to refer to the Services 

class. 

  

Create the Test Code 

Open Module1.vb and locate the Sub Main procedure. 

Paste the following code in the file to call the appropriate Web methods:  

Dim strValue As String = "This is my message" 

Dim myService As New WebService.Services() 

Console.WriteLine(myService.GetMessage) 

Console.WriteLine(myService.SendMessage(strValue)) 

Console.WriteLine(myService.ReverseMessageFunction(strValue)) 

myService.ReverseMessageSub(strValue) Console.WriteLine(strValue) 

Test the Client Application 
 

   Create a breakpoint on the following line: 
 

   Console.WriteLine(myService.GetMessage) 


   In Solution Explorer, right-click the TestHarness project, and then click 

Set as StartUp Project. 


   On the Debug menu, click Start and wait for the program to enter debug 

mode. 


   On the Debug menu, click Windows, and then click Locals. Use the Locals 

window to view the value of the strValue variable during the debugging to 

observe any changes that are made to the variable. 


   On the Debug toolbar, use Step Into to step through each line of code from 

the TestHarness client into the XML Web service. 


   Before you end the Main subroutine, confirm that the output in the console 

window is as expected. 
 

   When the program ends, remove the breakpoint and close Visual Studio 

.NET. 

Web Services Description Language (WSDL) 
    Web Services Description Language (WSDL) is a format for describing a Web Services 

interface. It is a way to describe services and how they should be bound to specific network 

addresses. 

WSDL 


   Web Services Description Language (WSDL) 




   Web Services Description Language (WSDL) is a format for describing a Web 

Services interface. It is a way to describe services and how they should be bound to 

specific network addresses.  

 

 

WSDL has three parts: 


   Definitions 


   Operations 


   Service bindings 


   Definitions are generally expressed in XML and include both data type 

definitions and message definitions that use the data type definitions. 


   These definitions are usually based upon some agreed upon XML vocabulary. 

This agreement could be within an organization or between organizations. 


   Vocabularies within an organization could be designed specifically for that 

organization. They may or may not be based on some industry-wide 

vocabulary. 


   If data type and message definitions need to be used between organizations, 

then most likely an industry-wide vocabulary will be used. 


   XML, however, is not necessary required for definitions. The OMG Interface 

Definition Language (IDL), for example, could be used instead of XML. 


   If a different definitional format were used, senders and receivers would need 

to agree on the format as well as the vocabulary. Nevertheless, over time, 

XML-based vocabularies and messages are likely to dominate. 


   XML Namespaces are used to ensure uniqueness of the XML element names 

in the definitions, operations, and service bindings. 


   Operations describe actions for the messages supported by a Web service. 

There are four types of operations: 


    One-way: Messages sent without a reply required 


    Request/response: The sender sends a message and the received 

sends a reply. 


    Solicit response: A request for a response. (The specific definition 

for this action is pending.) 


    Notification: Messages sent to multiple receivers. (The specific 

definition for this action is pending.) 


   Operations are grouped into port types. Port types define a set of 

operations supported by the Web service. 


   Service bindings connect port types to a port. A port is defined by 

associating a network address with a port type. A collection of ports 

defines a service. This binding is commonly created using SOAP, 

but other forms may be used. These other forms could include 



CORBA Internet Inter-ORB Protocol (IIOP), DCOM, .NET, Java 

Message Service (JMS), or WebSphere MQ to name a few. 

SOAP (Simple Object Access Protocol) 
SOAP (Simple Object Access Protocol) is a messaging protocol that allows programs that 

run on disparate operating systems (such as Windows and Linux) to communicate using 

Hypertext Transfer Protocol (HTTP) and its Extensible Markup Language (XML). 
SOAP 


   SOAP (Simple Object Access Protocol) is a messaging protocol that 

allows programs that run on disparate operating systems (such as Windows 

and Linux) to communicate using Hypertext Transfer Protocol (HTTP) and 

its Extensible Markup Language (XML). 



   Since Web protocols are installed and available for use by all major 

operating system platforms, HTTP and XML provide an at-hand solution 

that allows programs running under different operating systems in a network 

to communicate with each other. 


   SOAP specifies exactly how to encode an HTTP header and an XML file 

so that a program in one computer can call a program in another computer 

and pass along information. 


   SOAP also specifies how the called program can return a response. 

Despite its frequent pairing with HTTP, SOAP supports other transport 

protocols as well. 


   SOAP defines the XML-based message format that Web service-enabled 

applications use to communicate and inter-operate with each other over the 

Web. 


   The heterogeneous environment of the Web demands that applications 

support a common data encoding protocol and message format. SOAP is a 

standard for encoding messages in XML that invoke functions in other 

applications. 


   SOAP is analogous to Remote Procedure Calls (RPC), used in many 

technologies such as DCOM and CORBA, but eliminates some of the 

complexities of using these interfaces. SOAP enables applications to call 

functions from other applications, running on any hardware platform, 

regardless of different operating systems or programming languages. 


   SOAP calls are much more likely to get through firewall servers, since 

HTTP is typically Port 80 compliant, where other calls may be blocked for 

security reasons. Since HTTP requests are usually allowed through firewalls, 

programs using SOAP to communicate can be sure that the program can 

communicate with programs anywhere. 




   Some of the advantages of leveraging SOAP include: 


   It is platform and language independent. 


                       SOAP provides simplified communications through proxies and 

firewalls, as mentioned above. 


   It has the ability to leverage different transport protocols, including 

HTTP and SMTP, as well as others. 


   Some disadvantages of leveraging SOAP include: 

 
   SOAP is typically much slower than other types of middleware 

standards, including CORBA. This due to the fact that SOAP uses a 

verbose XML format. You need to fully understand the performance 

limitations before building applications around SOAP. 


   SOAP is typically limited to pooling, and not event notifications, when 

leveraging HTTP for transport. What's more, only one client can use 

the services of one server in typical situations. 



   Again, when leveraging HTTP as the transport protocol, there tends to 

be firewall latency due to the fact that the firewall is analyzing the 

HTTP transport. This is due to the fact that HTTP is also leveraged for 

Web browsing, and many firewalls do not understand the difference 

between the use of HTTP within a Web browser, and the use of HTTP 

within SOAP. 


   SOAP has different levels of support, depending upon the programming 

language supported. For example, SOAP support within Python and 

PHP is not as strong as it is within Java and .NET. 


	UNIT-V
	.NET APPLICATION DOMAINS
	.NET REMOTING
	The .NET Remoting provides an inter-process communication between Application Domains by using Remoting Framework.
	.NET CODING DESIGN GUIDELINES
	.NET ASSEMBLY
	XML Web Service Application
	Web Services Description Language (WSDL)
	SOAP (Simple Object Access Protocol)
	SOAP (Simple Object Access Protocol) is a messaging protocol that allows programs that run on disparate operating systems (such as Windows and Linux) to communicate using Hypertext Transfer Protocol (HTTP) and its Extensible Markup Language (XML).

